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Introduction Objectives 
 
 

This manual is written to give you a step-by-step guide for your 
classroom training and a handy reference for your daily work. In 
this Introduction, you will learn how to use this training guide 
effectively. This section covers the following topics: 
 

• An introduction to the Crystal Reports application 

• Pre-Qualification Exercise 

• Class objectives 

• Help with using this training guide 

• Information on how to start the program 
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About Crystal Reports 
 

In today's information intensive environment, every business has a database 
of some sort. After all, business today is all about information and databases 
give you a handle on the massive amounts of information you must deal with. 
Therefore, your business has a database and from that database, you need 
reports. The problem is, most reporting capabilities that come with database 
programs are limited. They only report on data from that program. Many 
users need to report on data from multiple sources, even databases that are 
in SQL (Structured Query Language), such as Oracle, Microsoft SQL Server, 
Informix or Sybase.  
 
Crystal Reports is one of the most powerful reporting programs available with 
the ability to pull data from all types of data sources. You can use Crystal 
Reports to generate reports from any of the standard PC database programs, 
Access, Paradox, or FoxPro, as well as from a mainframe or server 
database. Crystal also has a powerful web-reporting server that allows you to 
distribute your reports over the web.  
 
Crystal Reports is bundled with more than 160 other programs including 
Visual Basic, some medical applications, many accounting packages and 
several ERP solutions.  It makes report generation easy without requiring you 
to be a programmer or a database expert. If you know how to work in a 
Windows environment and are familiar with the data you want to use, you can 
create a Crystal Report that looks professional and makes sense. 
 

Training Philosophy
 
Studies show that people retain 10% of information they see, 20% of 
information they hear, 50% of what they see and hear, and 80% of what they 
see, hear and do. In line with this, this class utilizes a hands-on method of 
training. You will see the effects of new procedures on the screen, hear the 
instructor explain how and why to use features, and perform the actions 
yourself as you learn.  
 
In addition, this class focuses on your ability to perform tasks using the most 
productive techniques. The manual may contain several methods of 
accomplishing a certain task. However, class time does not allow for practice 
of all methods for each task. Your instructor will guide you in the most 
effective method of performing a task, but inform you of other methods that 
are available. 
 
Questions are encouraged. While we give our best effort to explain new 
concepts in understandable terms, you may need to hear the concept again 
or have it explained more thoroughly.  Please let the instructor know when 
you need more information! 
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Pre-Qualification Exercise for the Designer 2 Workshop 
  

Why Should You Pre-qualify Yourself for the Designer 2 
Workshop? 
 
The Crystal Reports Designer 2 Workshop is designed for the experienced Crystal 
Reports user. It covers the more complex and powerful features of the program. 
The class discusses very technical issues and includes several fast-paced, 
comprehensive exercises. Our instructors have years of experience helping 
students to get the most out of their training. However, it is not always possible in a 
high level workshop to assist students with basic tasks. 
 
In order to maximize the benefit you receive from the Crystal Reports Designer 2 
Workshop, you should come into the training with a certain skill level. We assume 
all students who sign up for this workshop have a comfortable level of 
understanding in regards to relational databases. Students should also be able to 
perform the following tasks in Crystal Reports: 
 

• Create a new report, insert fields, save the report and refresh the data. 
• Add multiple tables to the report using the Data Explorer. 
• Use the select expert to pull only the data needed from the database. 
• Insert groups and summarize fields within the group. 
• Perform formatting tasks. 
• Create, save and use formulas in the report. 

 
If you would like to evaluate for yourself whether this is the correct level course, 
take our self-evaluation exercise. The exercise consists of writing a report in 
Crystal Reports. When you are finished, compare your report to the one our 
experts have done to see how well you understand the basic features of Crystal 
Reports. You can obtain the exercise and the results report from the Vision Harvest 
web site, www.visionharvest.com, or by e-mailing us at sales@visionharvest.com. 
 
If you have trouble creating the report or getting the correct results, or if you cannot 
perform some of the above-mentioned tasks, then we strongly recommend that you 
take the Crystal Reports Designer 1 Workshop before attending the Designer 2 
Workshop. By assuring you are well prepared for the Designer 2 Workshop, you 
maximize the benefits you receive from this in-depth look at advanced report 
writing. 
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Pre-qualification Exercise 
 
Using the Xtreme sample database that ships with Crystal Reports, create a report 
invoicing customers for each order. The report needs to show the customer billing 
address, the PO#, the sales person, the order date, the requested date, the ship 
date and the company shipping the order. The Details section should list the 
product ID, the product name, size/color, the unit price, the quantity, and the line 
item total. 
  
Select only those orders with an Order Amount greater than zero and with a ship 
date between January 1, 2004 and March 31, 2004. Group on the Customer ID, 
then on the Order ID. Display each order on its own page. Sum the line item total 
amount for each Order ID. Calculate the sales tax for the order at 6% and total the 
subtotal and sales tax. 
 
You will need to pull data from the following tables: 
 
Customer  Product 
Orders   Product Type 
Orders Detail  Employee 
 
You will need to create the following formulas: 
 

• Line Item Total that multiplies the unit price times the quantity for each 
product ordered 

• Sales Tax that multiplies the sum of each line item total times 6% 
• Order Total that adds the sum of each line item total and the sales tax 
• Product Description that contains nested if…then….else statements to 

show the Size field if the Color field is empty, the Color field if the Size field 
is empty, and both fields, separated by a comma, if both contain data 

 
You will need to create the following text boxes: 
 

• An address box with the text To: then the company name, the address, the 
city, region postal code and country 

• An employee box with the employee first name, a space, then the last 
name 

 
Format the report to look like the illustrations on the following pages: 
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Class Objectives 
This class is a performance based instructional system. It is geared to 
provide you with the tools you need to build and distribute reports the 
quickest, most efficient way. After completing this course, you will be able to 
perform the following tasks: 
 
• Refresher Exercise 

• Use multiple sections in reports for advanced formatting techniques 

• Underlay graphics and charts to print beside data 

• Calculate running totals in reports 

• Develop parameter fields to prompt users for information 

• Limit user entry into parameter fields 

• Understand Crystal Reports data handling and Evaluation Time functions 

• Comfortably make use of variables in formulas 

• Work with arrays and control structures in formulas for more flexible 
decision making 

• Use additional reports within a main report as subreports 

• Create linked subreports to tie data from another report to the current 
report 

• Format subreports to display on demand only 

• Customize groups in the report with formulas and custom names and 
create hierarchical groups 

• Perform group selection based on summary field values 

• Create and format Cross-Tab reports and create charts from Cross-Tabs 

• Working with Report Alerts 

• Creating and using Report Templates 

• Solve table link problems with advanced linking techniques 
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About This Manual 
Each section of this manual contains objectives to provide you with the 
overall goals for the lesson.  Lessons have descriptions of features and 
concepts followed by systematic directions for completing a specific task. 
Each section ends with a challenge exercise to help you practice the skills 
you learned in the lesson. Challenge exercises provide you with tasks to 
accomplish. Try to complete these exercises on your own.  
 
As you work in this Training Guide, certain conventions are used to identify 
specific procedures. Use the following table as a guide: 
 

 
Training Guide Conventions 
Item Illustrated As 
Menu Commands Underlined letters for accessing menu commands are shown: 

 
Example:  File/Open 

Command Buttons Commands in dialog boxes are shown as buttons: 
 
Example:  
 

Categories, Radio 
Buttons, Text Boxes, 
Check Boxes 

All options within dialog boxes are listed in italicized text: 
 
Example: the Keep Group Together check box 
                 the Other radio button 

Keystrokes Keyboard keys are indicated by uppercase text: 
 
Example: press ENTER 
 
Keyboard combinations are shown in uppercase text with a plus sign 
(+) between the keys that need to be pressed simultaneously.  
 
Example: press CTRL + S to save 

Toolbar Buttons Toolbar buttons are indicated by the button name and a graphic 
image of the button: 
 
Example:  click the Print          button   

Typing or File Selections Text to be typed or file names to be selected are printed in bold 
letters: 
 
Example:  type Henry 
                 select grouping.rpt 

Exercises Step-by-Step exercises in the text are indicated by bold text and the 
 symbol. 

 
For example:   Exercise  - Format Objects 
 

ENTER
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Tips, Notes, and Warnings 
 
Tips, notes and warnings display with the following icons. Text for these 
additional comments display in bold and italics. 
 
 

This icon indicates a TIP or shortcut. 
 
 
 

This icon points out a NOTE of additional information. 
 
 
 
This icon calls attention to a WARNING or very important 
note. 
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Lesson Objectives 
 

After completing this lesson, you will be able to: 
 
• Plan and Create a report from a set of business requirements 

Review the techniques needed to plan and create a report 
 
• Add multiple groups to reports 

Create groups within groups to subdivide your reports how you want 
 
• Summarize different group levels 

You can effectively summarize information at any group level or all 
group levels 

 
• Insert simple lines and boxes for formatting 

Make reports professional and attractive with graphical features 
 
• Utilize the Repeated Group Header feature 

Add a "Continued…" message when a group prints across pages 



 

 17

Crystal Reports XI Designer 2 Workshop ©2006 Vision Harvest, Inc.
Lesson 1: Refresher Exercise 

Review of Planning a Report 
 

To make the report creation process efficient, you must plan the report. A 
little work up front before you ever open Crystal Reports can save a lot of 
time putting the report together.  It can also save problems caused by 
adding incorrect tables to the report, which can affect the accuracy of the 
records displayed.  
 
You must look at the business requirements for the report and decide what 
fields you need and the tables in which they are located. It is also helpful to 
look at things such as groupings, whether you need Cross-Tabs, fields 
needed for formulas and selection criteria.  
 
Suppose someone asks you to create a report based on the Xtreme 
Sample Database 11. Below are the business requirements for the report: 
 
The person requesting the report needs to see monthly customer sales by 
Supplier and Product Type. They want the Order ID, the Product Name, the 
line item Unit Price and Quantity and a total for the line items. 
 
• They want the sales amounts summarized for each supplier, product 

type and month. 

 
• They only need to see sales for 2004. 

 
• Some of the groups are large enough to display on more than one 

page. They want the Supplier Name and Product Type repeated at the 
top of each page. If the Product Type group continues from the previous 
page, they want the word "Continued…" to print. 

 
• The person requesting the report has supplied you with a printout of 

what the report should look like.  See the sample on the next page. 
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To create this report, first determine which fields you need.  
 
• For the Detail section, you need the Order ID field, Product Name field, 

the Unit Price field and the Quantity field 

• For the Line Total formula, you need to multiply the Unit Price field and 
the Quantity field   

• For grouping, you need the Supplier Name, the Product Type Name, 
and the Order Date. 

• Finally, you need to select orders from 2004 based on the Order Date 

 
Next, decide which tables you need to add to get the required fields. 
 
• The Supplier Name field is in the Suppliers table 
• The Product Name field is in the Products table 
• The Order ID and Order Date fields are in Orders 
• The Unit Price and Quantity fields are in Orders Detail 
• The Product Type Name field is in the Product Type table 
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Since the Supplier Name is the main grouping, the Suppliers table should 
be the Primary table. From there you want to link Suppliers to Products with 
the Supplier ID field, link Products to Orders Detail with the Product ID field, 
link Orders Detail to Orders using the Order ID field, and finally, link 
Products to Product Type using the Product Type ID field. 

 

Creating the Report 
 

Since you have given this some thought and figured out the tables and the 
links, adding the tables in the correct order and creating the links is easy. 
The links should look like the following illustration: 

 

 
Remember you can add multiple tables to a report from the Database 
Expert. You work with links using the Links tab on the Database Expert. 
The Database Expert is accessed under the Database menu or by 
selecting the Database Expert  button on the Expert Tools toolbar. 

 
The order in which the tables are displayed in the Link tab is based on 
the order in which the tables are selected on the Data tab. i.e. if 
Supplier is selected first; it becomes the first table on the Link tab.  
The order and links of the tables can be manually changed once they 
are displayed in the Link tab. 
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Placing Fields on the Report 
 
Remember you have five ways of placing fields on a report. Select the field 
in the Field Explorer, then: 
 
• Click the Insert button, and then click in the report 
• Double click the field, and then click in the report 
• Press ENTER, and then click in the report 
• Drag the field to the report 
• Right mouse click, choose Insert to Report from the short cut menu, and 

then click in the report 
 
Remember, when you place a field in the Details section, Crystal Reports 
adds a detail field title in the Page Header section and aligns the field and 
field title with a guideline. You can drag the guideline marker in the ruler to 
move the field and its title together. 
 
Now that you have planned the report, you are ready to use Crystal 
Reports to create the report. 
 

 Exercise 1.0  - Begin the Monthly Sales by Supplier and 
Product Type Report and Link the Tables Needed 

 
1. Start a new report as a blank report. Open the Create a New 

Connection folder then the ODBC (RDO)  data sources and the 
Xtreme Sample Database 11 data source. No password is needed to 
access this database. Add the tables indicated by the business 
requirements. Right click on the data source and select Add to 
Favorites as we shall be using this database throughout the class. 

 
2. The Auto-Link feature should link the tables automatically.  Clear the 

links and do them yourself. 
When you are finished the links should look like the illustration on the 
previous page. 

 
3. Add the appropriate fields to the Details section. 
 
4. Change the Printer Setup to a Portrait page layout, if necessary. 

Change the margins to be .5” on all four sides. 
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Creating the Formulas 
 
You are also going to need two formulas for this report. It can be helpful to 
write out the formulas during the planning stage to be sure you have 
accounted for all necessary fields. The formulas you need for this report are 
as follows: 
 
@Line Total  
{Orders_Detail.Unit Price} * {Orders_Detail.Quantity} 
 
@Continued 
          If InRepeatedGroupHeader then “ Continued...." 
 
 
Remember formulas are created from the Field Explorer dialog box. Select 
Formula Fields, and then click the New  button. After naming the formula, 
the Formula Editor dialog box opens providing you with three lists to select 
fields, functions and operators. 
 

 Exercise 1.1 – Create the Formulas and Add to the Report 
 
1. Select Formula Fields: in the Field Explorer dialog box, then click the  

button. 
 
2. Name the formula Line Total and select OK. 
 
3. Create the formula shown above. 
 
4. Add the formula to the report Details section after the Quantity field. 
 
5. Create the Continued formula, but do not add it to the report yet. 
 
You will add this formula later to display a "Continued" message in the 
group header.  
 

NOTE: The InRepeatedGroupHeader function is a function in 
the Print State category. Click the + sign to the left of Print 
State in the middle list in the Formula Editor, and then scroll to 
find the function. Double click the function to add it to the 
formula. 
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Advanced Grouping 
 
You can group data by using the Insert/Group… command or by clicking 
the Insert Group button  on the Insert Tools toolbar or the Group Expert 
button  on the Expert Tools toolbar. This report requires an Order Date 
group nested inside a Product Name group, nested inside a Supplier Name 
group as shown in the Group Expert illustration below. 
 

 
 
As you create groups, Crystal Reports nests each group inside the previous 
one you created. However, you can reorder groups in any order you want. 
To reorder groups, click the Group Header section name at the left of the 
Design screen, for the group you want to move. The group header and 
footer sections are highlighted. Drag the group to the new location. The 
mouse pointer changes to a grabbing hand as you drag.  In the Group 
Expert shown above you simply move the group headers using the arrows 
in the top right of the window 
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TIP: When you group on a date field, Crystal Reports allows 
you to define the period for which the date is broken down; 
i.e. monthly, yearly, quarterly, etc. A third drop-down list 
appears automatically in the Insert Group options dialog box 
allowing you to specify when the group is printed. 

 
 

 
 
Remember you can summarize any field by RIGHT clicking it, then 
choosing Insert Summary… You must specify the type of calculation you 
want Crystal Reports to perform and the group at which you want the 
summary to appear. 
 

 Exercise 1.2 – Create groups and summarize the Line Total 
field 

 
1. Open the Group Expert window using the Group Expert  button. 

Create a group on the Product Type Name field. Turn on the Repeat 
group header on each new page feature by selecting the Options button 

 
2. Create a second group on the Supplier Name field. Also, turn on the 

Repeat group header on each new page feature.  
 
3. The report requirements call for the report to display information by 

Supplier Name and then Product Type. You need to change the order 
of the groups. Select the Product Type Name field in the Group By 
window of the Group Expert (  ). Select the Down Arrow to reorder the 
groups. 
The Supplier Name should be the first group in the Group Expert with 
the Product Type name nested underneath. 
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4. Create a third group on the Order Date. Choose to print the section for 

each month. Using the Options tab check on the Keep Group Together 
item. 

 
5. Create a summary for the Line Total column. You will need to do this 

three times, once for each group. 
All the summary fields should automatically line up on the guideline to 
which the field is attached. 

  

 
 
 

Selecting Certain Records 
 
Remember Crystal Reports pulls all records from the database unless you 
filter the records based on some criteria. The business requirements for this 
report requests only records from the year 2004. To specify this, use the 
between operator and specify all records with an order date range 
beginning 01/01/04 and ending 12/31/04. 
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 Exercise 1.3 – Select records with an Order Date in 2004 
 
1. Make sure there are no fields selected on the report, and then click the 

Select Expert  button on the Expert Tools toolbar.  
 
2. Choose the Order Date field. 
 
3. Choose the is between operator. 
 
4. In the first drop-down list, select 1/1/2004 12:00:00AM. 
 
5. In the second drop-down list select 12/31/2004 12:00:00AM. Click OK 

when finished.  
  
6. At this point save and preview the report. Name the report Monthly 

Sales by Supplier and Product Type.rpt 
 

Helpful Hints for Formatting the Report 
 

Adding and Working with Text Objects 
 
Once you have created a group, you can delete the group name field from 
the group header without affecting the grouping. You can delete the 
Supplier Name and Product Type Name fields from Group Headers #1 and 
#2, and then create a text object in Group Header #2 containing the 
Supplier Name and Product Type Name.  
 
Remember text objects can contain text you type and fields from the report. 
You can add a field to a text object by dragging the field from the Field 
Explorer dialog box into the text object. Once you have a field selected, the 
mouse pointer changes to an arrow with a + sign when you are pointing into 
a text object. You can also move a field from the report into a text object. 
The text object must be in Edit Mode (flashing insertion bar in the text box 
and a small ruler in the horizontal ruler at the top of the report). 
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Also remember you can format all or part of a text object: 
 
• To format the entire text object, select the object (there are handles 

around the object) then apply the formatting 
 
• To format part of a text object, double click the object to enter Edit 

Mode, and then select the part you want to format. When the part is 
highlighted, apply the formatting 

 
• To format a field inside a text object, double click the object to enter Edit 

Mode, and then click on the field. Once the field is highlighted, apply the 
formatting 

 
Hiding and Suppressing Sections 
 
Remember you can hide or suppress sections in a report by RIGHT clicking 
on the section name in Design view and choosing the appropriate 
command. Hiding a section causes the section to not display in the Preview 
tab. However, users can double click summaries to display hidden details. 
Suppressing a section causes the section to not display without any options 
for viewing it. A hidden or suppressed section will be grayed out in the 
Design tab. 
 

Guidelines 
 
As a reminder, you can add horizontal guidelines to the rulers at the left of 
each section and snap the tops or bottoms of objects to the guidelines to 
horizontally align them. 
 
 

 Exercise 1.4 - Format the Report 
 
1. Return to the Design view. It is easier to add and format objects from 

Design view. 
 
2. Add the title and format as you see it in the sample report on page 28.  

Add the Xtreme logo (included in class files) to the right side of the 
Report Header. 

 
3. Delete the Group #1 Name and Group #2 Name fields from Group 

Headers #1 and #2. 
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4. Using the sample report as a reference, create a text box in Group 
Header #2. Type the text Supplier Name: then add the Group #1 
Name: Supplier Name field from the Group Name fields in the Field 
Explorer. On the second line of the text object, type the text Product 
Type: then add the Group #2 Name: Product Type Name field. 
Format all objects in the text box to Bold. You may need to resize the 
text box. See the sample on the next page for final formatting.  
HINT: Format the text object border rather than drawing a box around 
the object. It is easier and you only have one object to deal with, plus if 
you resize the text object the border will grow with it whereas a box will 
not. 

 
5. Suppress Group Header #1. It no longer contains anything you need to 

see in the report.  
 
6. Add a text box to the Group Footer #1 with the text Total for this 

supplier:. Move the summary field into the text object. Format the 
entire object to be Bold, 14 pt., and right aligned. 

 
7. Add a text box to the Group Footer #2 with the text Total for this 

product type:. Move the summary field into the text object. Format the 
entire object to be Bold and right aligned.  

 
8. Format the summary field in the Group Footer #3 section to have a top 

double line border. Make sure the summary field and text boxes are all 
snapped to the guideline on their right edges so they line up. 

 
9. Snap the field titles to a horizontal guideline. Use the guideline to move 

the field names from the Page Header section to the Group Header #3 
section under the Group #3 Name field. Format the titles so they have 
no underline.  
By placing the titles in this section, the titles will reprint with each 
month’s data. 

 
10. Format the Order ID field to display without a comma. Format the Unit 

Price field, the Line Total formula, and all the summary fields to have a 
floating $. 
HINT: Refer to the bullets on page 26 for directions on how to format 
the summary fields inside the text boxes. 

 
11. Depending on how you have the default formats set for Date/Time 

fields; you may need to reformat the Group #3 Name fields. The date 
should look like this: January 2004. 

 
12. From the Special Fields list, add the Page N of M field to the left side 

of the Page Footer. Add a text box on the right side of the page footer 
that reads Order information as of. Add the Data Date special field 
after the text. Format both items to be italisized. 
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13. To add the word "Continued…" for a product or supplier group 
continued on an additional page, place the @Continued formula field in 
the text object containing the Supplier and Product Names. 

 
14. Save and preview the report. Do not forget you can navigate easily 

through the report using the Group Tree section at the left of the 
screen. Just click the group you want to view. Close the report. 

 
The Design view of the report should be similar to the following illustration: 
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Notes Page
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Lesson Objectives 
 

After completing this lesson, you will be able to: 
 
• Understand What a Subreport Is 

Learn how and why you would want to use subreporting 
 
• Insert a Subreport into a Container Report 

Combine existing reports to create one report that has all the 
information you need 

 
• Link a Subreport to its Container Report 

Create subreports that link to the data in the main report, so the 
subreport displays only data related to the current record or group 

 
• Format Subreports 

Look at the options available for formatting your subreport 
 
• Pass a Value from the Main Report into the Subreport  

Sometimes it is necessary to bring values from the subreport back into 
the main report. Learn how to use a shared variable to share data from 
the subreport with the container report 

 
• Understand How to Link "Unlinkable" Data Using Subreports 

Link fields with different data type by using subreports in combination 
with formula fields 
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Understanding Subreports 
 
A subreport is a report within a report.  You create it in much the same way 
as you create a regular report.  A subreport has most of the characteristics 
of a primary report, and it can have its own record selection criteria.  The 
only difference between a subreport and a primary report is that a subreport 
is an object in a primary report and it cannot itself contain a subreport. 
 
There are four typical times that you would want to use a subreport: 
 
• When you want to combine unrelated reports into a single report 
 
• When you want to coordinate data that cannot be linked otherwise 
 
• When you want to present different views of the same data in a single 

report 
 
• When you are doing too many lookups from a field that is not indexed 

on the lookup field 
 

Unlinked versus Linked Subreports 
 

 
Unlinked subreports are freestanding reports used within another report. 
Their data is not coordinated with the data in the primary report in any way. 
What this means is that there is no attempt to match up the records in one 
report with the records in the other. Regardless of the underlying data 
sources, Crystal Reports treats the reports as unrelated. 
 
Linked subreports are just the opposite.  Their data is coordinated.  The 
program matches up the records in the subreport with the records in the 
primary report.  If you create a primary report with customer information and 
a subreport with order information and link them, the program creates a 
subreport for each customer and includes in that subreport all the orders for 
that customer. 
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Creating an Unlinked Subreport 
 

To create an unlinked subreport, use the Insert/Subreport command from 

the menus, or click the Insert Subreport  button on the Supplementary 
toolbar. The Insert Subreport dialog box displays. 
 

 
 
 
There are two methods to create a subreport.  Any existing report can be 
used as a subreport by simply selecting the Choose a report option in the 
dialog box.  This allows you to locate the report in Windows Explorer and 
bring its definition into the primary report.  You can even use the Report 
Wizard to create a new report on the fly by selecting the Create a subreport 
option. Once you have created a report or selected one, click in the 
container report in the section where you want the subreport to print. 
Crystal Reports places the subreport in the section in which you clicked.  
Note the subreport is a separate query so if you place it in the details 
section it will run for each detail record. 
 
When you preview a report with a subreport, Crystal Reports creates an 
additional tab. Now you have a Design tab for the main report, a Preview 
tab, and a subreport Design tab labeled with the subreport name. 
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 Exercise 6.0 – Create a Report to Contain an Unlinked 
Subreport 

 
In order to get familiar with unlinked subreports, you are going to create two 
independent reports and bring them together using the Choose a report 
option in the Insert Subreport expert.  The primary report will contain 
information for Customers in the USA with the Last Year’s Sales amounts 
summarized by region.  The subreport will contain a chart displaying the top 
five sales people for 2004. 
                                                                                                                                        
1. Start a new Blank report based on the Xtreme Sample Database 11. 

Use the Customer table. 
 
2. Select only those records with a country of USA. 
 
3. Group on Region 
 
4. Add the Customer Name and Last Year's Sales fields to the Detail 

section. 
 
5. Summarize the Last Year's Sales field. 
 
6. Move the Group #1 Name field (region) to the group footer at the left 

margin. Change the text in the first field title from "Customer Name" to 
"Region." 

 
7. Add a title with the text “Last Year’s Sales by Region”. Format the title 

and column headings how you like. 
 
8. Hide the Detail section so you only see a list of regions and their 

summary sales. 
 
9. Save the report. Name it Sales by Region.rpt. Preview the report, then 

return to Design view. 
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Your report should look like the following illustration: 
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 Exercise 6.1 – Create the Subreport 
 
1. Start a new report based on the Employee and the Orders tables. 
 
2. Select only those records with an order date in 2004. Use the between 

operator. 
 
3. Group on Employee Last Name, then move the Group #1 Name field 

into the Group Footer section at the left. Resize it to be about 1.5” 
long. 

 
4. Add the Order Date and the Order Amount fields to the Detail section, 

and then summarize the Order Amount field, using Sum. 
 
5. Hide the Detail section, suppress the Page Header section, and 

suppress all empty sections except the Report Header. 
 
6. Apply Group Sort Expert… TopN selection to display only the top 5 

groups. Do not include Others – this is the default.. 
 
7. Create a side-by-side bar chart in the Report Header that shows the 

summed Order Amounts for each employee by last name. When 
choosing the bar chart select Use Depth Effect to make the chart 3D.  
On the Axes tab, set the Min to 400000, the Max to 540000, and the 
Number format to $1K. Add a title of Top Five Sales People for 2004. 
Delete all other titles. 

 
8. Save the report. Name it Top Sales People for 2004.rpt. Preview the 

report. 
 
9. Once you are sure the graph looks correct and the data displays only 

the top five employees, hide the Group Footer section. 
Only the graph should display in the report. 

 
10. Save the report and close it. 
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The graph should look like the following illustration: 
 

 
 
 
 

 Exercise 6.2 – Insert a Subreport into a Report 
 
1. Make sure the Sales by Region.rpt report is open on the screen in 

Design view. You want to insert this subreport in the Report Header. 
However, the title is also in the Report Header.  You want to underlay 
the subreport, but not the title. Therefore, you have to add an additional 
section to the Report Header area. The title is already in Report 
Header a. The subreport will go into Report Header b. Start by 
inserting the additional section in the Report Header. RIGHT click the 
section name and choose Insert Section Below. 

 

2. Click the Insert Subreport  button on the Insert toolbar. 
 
3. Click the Choose an existing report radio button. 
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4. Use the    button to locate the report, then click OK.                   
The mouse pointer has a shadow box attached to it. 

 
5. Click into Report Header b as far to the right side as you can. 

You may have to resize the subreport to about 5” wide so that it does 
not cover the regional sales data. 

 
6. Underlay Report Header b. 
 
7. Save and preview the report. 
 
8. Click the subreport tab to see the Design view of the subreport. 
 
9. If you need to see the subreport in Preview view, click the Preview   

button on the toolbar  
Notice a 4th tab containing the preview for the subreport 

 
10. To return to Design view, click the  button in the Preview navigation 

area. 
 
11. Your report should look as follows: 
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Linking a Subreport  
 

When you link a subreport to a primary report, the program creates the link 
through the mechanism of a parameter field.  
 
When you link a subreport, Crystal Reports: 
 
• creates a parameter field in the subreport that relates to the field to 

which you are linking 
 
• creates a record selection formula for the subreport using the parameter 

field 
 
• when you preview the container report, Crystal Reports limits the 

subreport to those records which match the parameter field's value 
 
When you run the report, the program finds the first record it needs and 
passes the value in the linked field to the parameter field in the subreport.  
The program then creates the subreport with record selection based on the 
parameter field value.   
 
Here is an example: 
 
You create a report that shows customer data and a subreport that shows 
order data and you link the two reports using the Customer ID field. 
 
When you run the report, the program finds the first customer record it 
needs and passes the Customer ID value from that record to the subreport 
parameter field.  The program runs the Orders subreport.  Since the 
subreport selection formula selects only those records in which the 
Customer ID value is equal to the parameter field value, and, since that 
parameter field value is equal to the Customer ID in the first record in the 
primary report, the subreport contains only those records that have the 
same customer ID. 
 
When the subreport finishes, the program goes to the second record it 
needs in the primary report, prints the customer data, and then passes this 
customer's ID number to the parameter field.  
 
The program then runs a subreport including only those order records for 
the second customer. The process continues until the report is finished. 
 
All of this parameter field manipulation takes place behind the scenes.  You 
simply pick the fields you want to use to link the primary report with the 
subreport, and Crystal Reports does the rest.  The program passes values 
to the subreport without the parameter field prompting you for a value. 
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NOTE: If you are in the Design view for a linked subreport and 
you click the Preview button on the toolbar, the program runs 
the subreport on its own, without first receiving a parameter 
field value from the primary report. In this case, the program 
displays the Enter Parameter Values for Subreport dialog box 
prompting you for a value.  
 
In addition, since the program creates a parameter field, that 
parameter field is available on the Fields list in the Formula 
Editors for any other needs you may have for it. 
 
TIP: If you need to link fields that are not the same data type, 
you can do so by creating a formula. This is useful for linking 
fields that are number data type in one table and a string data 
type in another table. 

 
 

Database Links versus Subreports in One-to-Many Situations 
 

When two tables in your report have a one-to-many relationship, the 
program retrieves the data in different ways depending on the data source, 
the index situation, the record selection criteria, and whether you are 
creating a single report based on linked tables or a primary report that 
contains a subreport. 
 
When you are considering whether to use linked tables or a subreport, you 
need to understand the ramifications of doing it each way. As a general 
rule, if you have indexed tables, if you are linking on the indexed fields, and 
if you have record selection criteria based on the indexed fields, the 
program reads the same number of records whether you are linking tables 
in a single report or using a subreport.  
 
For more in depth information about performance in a one-to-many 
situation, look up the Crystal Reports Help topic Performance 
considerations in one-to-many links. 
 
 

 Exercise 6.3 – Create a Container Report with a Linked 
Subreport 

 
You are going to modify the Sales by Region report to include a linked 
subreport that displays customer orders for this year that are greater than 
$1,000. The main report will no longer contain the graph. The subreport will 
show Order ID, Order Date and Order Amount of orders over $1,000 for 
each customer. The Order Amount is totaled for each customer. 
 
1. Sales by Region report should still be open in Design view. 
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2. Select and delete the subreport. Delete the Report Header b section by 
RIGHT clicking the section name and choosing Delete Section. 

 
3. RIGHT click the Details section and show it again. Do the same for the 

Group Header #1 section, if necessary. 
 
4. Move the Group #1 Name field into the Group Header #1 section. 
 
5. Add a label in the group footer – Region Total: 
 
6. Delete the Region field title in the Page Header section. Move the Last 

Year's Sales field title from the Page Header to the Detail section after 
the Customer Name but before the Last Year's Sales. 
The Details section should look like this: 

 
[Customer Name]    [Last Year's Sales]  [Last Year's Sales] 

 
7. Insert an additional Details section below the current one. 

This section is going to contain the subreport. 
 
8. Using the Save As command in File menu, save the report as Sales by 

Region with Order Info.rpt
 
The report should look like the following: 
 

 
 
 

. 
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The subreport is a listing of order amounts greater than $1000 for 
customers in USA in 2004. 
 

 Exercise 6.4 – Create the Subreport 
 
1. Create a new report, using the Customer and Orders tables 
 
2. Insert the Order ID, Order Date and Order Amount fields in the 

Details section. 
 
3. Select for Country equal to USA, Order Date between 01/01/2004 and 

12/31/2004, and Order Amount greater than 1000. 
 
4. Group on the Customer ID field. 
 
5. Add a text object to the Report Header with the following text:  

 
Orders Greater Than $1,000 

 
 
6. Insert a text object into the group header with the text Customer:. Move 

the Group #1 Name field into the text object. Add a space, hyphen, and 
space after the field. Insert the Customer Name field into the text 
object. 
The text object should look like this: 

 
Customer: {Group #1 Name} – {Customer Name} 

 
7. Create a Summary field for the Order Amount field, and then add a 

text object to the left with the text Total Amount:. 
 
8. Format the date field to display only a date and remove the comma 

from the Order Id field. 
 
9. Suppress the Report Footer  and Page Footer 
 
10. Save the report as Orders Over 1000.rpt and close it. 
 

 Exercise 6.5 – Inserting the Subreport into the Container 
Report 

 
You are now ready to insert the Exercise6_4.rpt into the Container report. 
 
1. Make sure the Sales by Region with Order Info.rpt report is open in 

Design view. Click the Insert Subreport  button. 
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2. Click the Choose a report radio button, and then browse to select 

Orders Over 1000.rpt as the report file. 
 

3. Click the Link tab. 
 
4. Select the Customer_ID field in the Available fields list, then click the    

       button. 
 

Crystal Reports automatically selects the Customer_ID field in the 
Select data in subreport based on field: box. Notice the name of the 
parameter that will be created in the subreport.  Note that if you drop 
down the list of available fields to link to only fields of the same data 
type are available for selection. 

 
5. Click OK.                  
 
6. Place the subreport into the Details b section. 
 
7. Format the report to look like the example below. 
 
8. Save the report (Sales by Region with Order Info) and preview the 

report 
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The final report should look like the following illustration: 
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Formatting the Subreport 
 

Before we look at passing information from the main report into the 
subreport, let’s look at some of the formatting options available for your 
subreport.  For example, in our exercise we just completed the subreport 
has a border we do not want.  Right click on the subreport and choose 
Format Subreport.  Click on the Subreport tab and you should see the 
following. 
 

 
 
 
• You can change the name of the subreport so that when you are in the 

designer mode for the subreport you will see the name you choose here 
displayed on the tab 
 

• On Demand Subreports are covered later in the lesson 
 

• Preview Tab Caption – allows you to provide a caption for the preview 
tab. Since it is a formula it can contain database fields as well as text 
 

• Re-import When Opening – By default when a subreport is incorporated 
into the main report, any changes to the initial design of the subreport 
are not updated however if you check this box then changes will be 
incorporated.  This option can be set globally on the Reporting tab 
under File|Options|Reporting 
 

• Suppress blank subreport suppresses the subreport including display of 
title if there is no data 
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 Exercise 6.6 – Format the Subreport 
 
 
1. Open the Sales by Region with Order Info.rpt Report. 
 
2. Right click on the Subreport. 
 
3. Choose Format Subreport. 
 
4. Remove the border. 
 
5. Click on the Subreport tab. 
 
6. Change the Subreport name to Orders Subreport 
 
7. Click on the conditional formatting button for the Subreport Preview Tab 

Option. Type the following formula:  
 

{Customer.Customer Name} + "-Orders Over $1,000" 
 
8. Click on the Re-import When Opening check box. 
 
9. Save the report as ( Sales by Region with Order Info ). 
 
10. Right click on the Subreport and choose edit Subreport. 
 
11. Go back to the main preview window and double click on the 

Subreport. 
 
12. You should have the following tabs and no border around the 

Subreport: 
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13. Close the report. 
 
14. Open the report Orders Over 1000.rpt and insert a text box saying 

Modified Report. 
 
15. Save and close the report. 
 
16. Open the Sales by Region with Order Info.rpt report. 
 
17. You should see the changes reflected in the subreport since you 

checked the option - Re-Import When Opening.  
NOTE: –If you choose to edit the subreport from within the main report 
the original report is not changed and none of these changes will be 
saved if you then re-import the original.  

 
18. Before saving turn off the check box to Re-Import When Opening. 
 
 

Passing Data from the Main Report into a Subreport 
 

The final report now looks almost like you want, but not quite. Suppose that 
the requirements for the report specify that each customer's information 
print on a separate page that will be distributed to the sales rep for that 
company. At the top of each page, you want the Region repeated, and at 
the bottom of the page, you need to put the total of Last Year's Sales for 
the entire region. 
 
The repeated group header and the page breaks are easy. Simply edit the 
Region group in the main report and specify to repeat the group header on 
each page. Then format the Details b section to have a page break after 
the section. 
 
However, the regional total Last Year's Sales figure on each page is a little 
trickier. Since this is a summary operation, it only appears one time at the 
end of the Region group in the main report, not on every page. One way to 
make this data appear on each page would be to put the data into the 
subreport that prints for each customer (on each page). If you want to show 
a total from the main report in the subreport, you can pass data from the 
main report into the subreport. This feature is useful for purposes like the 
one described here or for any situation where you have to calculate values 
from both reports. 
 
To pass values from the main report into the subreport, we use shared 
variables in a formula.  We create a field in the main report with a shared 
variable set to the value we would like to pass to the subreport. Our formula 
in the subreport declares the shared variable and then uses it to calculate 
the field required. 
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 Exercise 6.7 – Pass the Total Last Year's Sales for the Region 
to the Subreport 
 

1. In the Sales by Region with Order Info main report create a formula 
named LYS by Region main, with a shared currency variable whose 
value is the sum of last year’s sales by region.  The formula text reads 
as follows: 
 
shared currencyVar  LYSBYRegion := Sum ({Customer.Last Year's 
Sales}, {Customer.Region});   
 
NOTE: The variable declaration MUST say shared for this variable to 
be available for use in the subreport. 

 
2. Double click on the Subreport or right click and choose edit to go into 

design mode for the Subreport.  Create a formula named LYS by 
Region sub in the Subreport that simply declares the shared variable 
we just created.  This formula will have the last year’s sales numbers for 
that region passed into the subreport and will read as follows: 
 
Shared CurrencyVar LYSBYRegion;  

 
NOTE: It is important to make sure the variable name is the same as in 
the main report formula. Otherwise, Crystal Reports will not recognize 
the variable being referenced. 

 
3. Show the Report Footer again. Add a text object to the Report Footer 

of the subreport that reads Total Last Year's Sales for. Add the 
Region field. Add the formula field to the Report Footer after the text 
object. Format both fields to be bold and 14 pt. Format the formula field 
to display a floating currency symbol. Resize as necessary. 

 
4. Draw a line above the fields to separate this information from the 

orders. 
 

5. Click the Design tab to return to Design view for the main report. 
 
6. Select the Group #1 Name field and make it bold and 14 pt. RIGHT 

click the Group Header #1 section name and choose Change Group… 
Click the Options tab and add a check mark to the Repeat Group 
Header On Each Page box. 

 
7. Format the Details b section to start a new page after the section. 
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8. If you preview the report right now you will see that the value in the 
Subreport is zero which is not what we would expect.  When you pass 
information from the main report to the Subreport the formula in the 
main report needs to be inserted into the report in a section above the 
Subreport.  In this case we shall put the formula in the Group Header.  
Do this and notice the values are as we would expect.  Now suppress 
the formula field so it does not display on the report. Use the Suppress 
option on the Common tab of the Format Editor. 
 

9. Finally, suppress the Group Footer #1 section so it does not display on 
the top of the pages for each new region. 

 
10. Save the report (Sales by Region with Order Info.rpt) and Preview 

the report. 
 

 
 

 
NOTE: Once a report has been added to another report as a 
subreport, it maintains no link to the original report. However, 
if you do make changes to the original report, you can re-
import it by RIGHT clicking the subreport object and choosing 
Re-import subreport. 
 
You can also set Crystal to re-import all subreports 
automatically when you open the main report. This command 
is in the File|Options|Reporting tab. 
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Creating On-Demand Subreports 
 

Crystal Reports allows you to create on-demand subreports; that is, 
subreports that do not show in the main report until the user drills down on 
them.  
 
An on-demand subreport is represented in the main report by an object 
frame. This reduces the bulk of the main report and makes it easier to 
manage. In addition, the subreport data is not read from the database until 
the user drills down to display the subreport. 
 
There are two ways to make a subreport display on-demand: 
 
• When you first insert the subreport, toggle on the On-demand subreport 

check box in the Insert Subreport dialog box 
 

• If the subreport is already inserted, right click and select format 
subreport. Toggle on the On-demand subreport box 

 

 
 
You can also add an on-demand caption for the subreport by clicking the 
On-demand Subreport Caption conditional formula button and adding the 
text you wish to display. 
 

 Exercise 6.8 – Create an On-Demand Subreport 
 
1. Open the Sales by Region.rpt report. Return to Design view for the 

main report. Select the Subreport, and then click the Format  
button on the Experts toolbar. 

 
2. Click the Subreport tab. 
 
3. Toggle the On-demand subreport checkbox to on. 
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 4. To add a caption, click the  button after the On-demand subreport 

caption command. Type "Click here to see a graph of sales for the 
top five sales people in 2004", then save and close the formula and 
click OK. 

 
5. Change the section so that it does not underlay. 
 
6. Make sure the Subreport is not selected, then save and preview the 

report. 
Notice that all you see is the caption. 

 
7. To see the Subreport data, click the Subreport new caption. 

Crystal Reports opens a tab containing the subreport data. What you 
actually created here is a hyperlink. 

 
8. Delete the extra tab, and then save the report (Sales by Region). 

 

Creating Hyperlinks 
 

You can select any object on a report and create a hyperlink. The hyperlink 
is saved with the report and is available to other users as a way of viewing 
additional information. You can create hyperlinks to the following types of 
locations:  
 
• A website on the Internet  
• A file  
• A current field value  
• An e-mail address  
• A current e-mail field value 
• Another Crystal Report file 
 
To create a hyperlink field, select a report object, then open the Format 
Editor and click the Hyperlink tab. 
 
 
Click the type of hyperlink you want to create.  Not all hyperlink types are 
available at all times. The object you select and its location on the report 
determine which types are available. After you have chosen a hyperlink 
type, enter the appropriate hyperlink information (the URL of a web site, for 
example).  
Once the hyperlink is created, click it on the report to go to the appropriate 
site, e-mail address or other report. 
 

NOTE: If you create a hyperlink to another Crystal Report file, 
you are creating an on-demand subreport. Just as one 
subreport cannot contain another subreport, you cannot 
create a hyperlink between two subreports.  
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TIP: To select a hyperlink object in Preview view, use SHIFT-
click or CTRL-click. Clicking on a hyperlink, without using the 
SHIFT or CTRL key, activates the link.  
 

 
 Exercise 6.9 – Create a Hyperlink to a Web site 

 
1. Return to Design view in report Sales by Region.rpt , then add 

another Report Header section, Report Header c. Insert a text object 
with the words “Click Here to Visit My Company’s Web site”. 

 
2. With the text object selected Click the Insert Hyperlink  button on the 

Experts toolbar. Click the Website on the Internet button and enter the 
Web site www.yourcompany.com           

 
3. Format the text to look like a hyperlink  i.e. color blue and underline. 
 
4. Save as Sales by Region with Hyperlink.rpt and close the report. 
 

WARNING:  When creating hyperlinks, users will not be able 
to get to the hyperlink if they cannot access the location.  For 
example, if the user does not have the ability to access the 
internet, then the user will not be able to fully execute the 
hyperlink.  Likewise, if you have created a hyperlink to 
another report, the user must have permission to access the 
specified file location. 

 
 

Using Subreports to Link "Unlinkable" Data 
 

One important reason for using subreports is to link "unlinkable" data. For 
example, suppose you have a database with additional employee 
information in it, such as employee benefit. Suppose you need to create a 
report with Employee related information from the Xtreme sample database 
along with information from this external datasource. If the information 
resided in one database, then you would simply link the two tables on the 
Employee ID field and create the report. However, suppose the Employee 
ID field in the Benefits database is a string field (remember that Employee 
ID is a numeric field in the Xtreme database).   
 
You cannot create this report as a single report because you cannot link 
fields of different data types. Even when linking a subreport to a main 
report, the two fields that make up the link must have the same data type, 
so this might seem to be an insurmountable problem. However, the 
subreporting feature in Crystal Reports does provide you with an easy 
solution. Crystal Reports allows you to link to or from formula fields in the 
main report or the subreport. So you can use a formula field to convert the 
data to the correct data type, then link from the formula field to the 
subreport or from the main report to the formula field in the subreport. 
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Challenge Exercise – Creating Reports with Linked Subreports 
 

Create a Contact List report that looks like the example below: 
 

 
 
 
 
1. First, create the Customer List main report.  Use the Customer table.  

Group the records by Country. 
 
2. Place into the Details section the Customer Name field, a text object 

containing the Contact First Name and Contact Last Name fields.  
Place the Phone field to the right of the text object. 
NOTE:  You can use a formula to create the Contact First Name and 
Last Name instead of a text box. 

 
3. Expand the Group Header section to 1”.  Place a text object into the 

Group Header section with the text Customer Listing. 
 
4. Move all of the titles in the Page Header section to the Group Header 

section under the Customer Listing text box. 
 
5. Create a summary field using the count option for the Customer 

Names.  Place this summary into a text object in the Group Footer 
section.  The text box should look like the following: 

 
Total Customers: {Count of Customer.Customer Name} 

 
6. Format the report like the example above. 
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7. Save the report as Customer Listing.rpt. 
 
8. Create a subreport called Supplier List using the Supplier table.  

Group the records by Country. 
 
9. Place the Supplier Name and the Phone fields into the Details section.  

Change the text object for the phone column to Telephone. 
 
10. Create a summary field using the count option for the Supplier Names.  

Place this summary into a text object in the Group Footer section.  The 
text box should look like the following: 

 
Total Suppliers:  {Count of Supplier.Supplier Name} 

 
11. Delete the Group #1 Name field.  Add a text box to the Group Header 

with the text Supplier Listing.  Move the titles in the Page Header to 
the Group Header. 

 
12. Format the report to match the Contact List report. 
 
13. Save the report as Supplier Listing.rpt.  Close the report. 
 
14. Return to the Design view of the Customer Listing.rpt report.   
 
15. Create another Group Footer in which to place the subreport. 
 
16. Add the Supplier Listing.rpt report as a subreport to the Customer 

Listing.rpt report.  Link on the Country field. 
Check to be sure that the link specifies the correct field in the subreport.   

 
17. Place the subreport into Group Footer #1b. 
 
18. In both reports, suppress any empty sections to eliminate extra spacing.  

Also, delete the border on the subreport. 
 
19. You may have noticed that the field titles and text box from the 

Subreport display even if there are no suppliers for that country.  To 
suppress them, you must format the Subreport and section Group 
Footer #1b.  Right click the Subreport and format it to suppress if it is 
blank.  Format the Group Footer #1b section to suppress if it is blank. 

 
20. Format the Group Footer #1b to include a page break after each 

subreport.  
 
21. Save (Customer Listing) and preview the report.
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Lesson Objectives 
After completing this lesson, you will be able to: 
 
• Understand Report Alerts 

Understand what a report alert is and when to use one 
 
• Create Report Alert  

Learn how to set up a report alert and use it in a report 
 
• Use Report Alerts with Parameters 

Learn how to conditionally establish a triggered alert with an input value 
into a parameter field 

 
• Create Formulas based on Report Alerts 

Generate formulas that calculate or control formatting options based on 
triggered alerts 

 
• Identify Creative ways to use Report Alerts  

Use Report Alerts as a form of data analysis by creating queries against 
saved data 
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What are Report Alerts 
 

In today’s busy, data-driven business world it is not surprising to see many reports focused on identifying 
problems or conditions which are outside the norm. This type of report is referred to as an exception 
report and is very useful at helping report viewers quickly get to the key indicators they need to make 
better decisions. 

 
Now all reports can offer exception reporting through a feature called Report 
Alerts. Report Alerts are custom messages that appear when certain conditions 
are met. Some possible uses are: 
 

• A daily report summarizes all customer orders for the day and the sales 
manager needs to know when an order by a key customer cannot be 
fulfilled 

 
• The accounting department at a manufacturing plant runs a bi-weekly 

payroll report detailing the next payroll and also wishes to be alerted if 
payment for over-time exceeds regular pay by 3% or more 

 
• A key management report is run weekly which identifies 50 Key 

Performance Indicators(KPI) of the company’s financial well-being. Five of 
these KPI’s are considered mission-critical and top management needs to 
be informed immediately if any of these five indicators fall outside their 
“safe” range 

 
• A weekly sales report summarizes all sales reps’ actual sales against their 

sales goals. The sales manager wants to be notified whenever someone 
either exceeds or is severely short of their goal 

 
Report Alerts are the first step towards pushing reports to wireless devices since 
they are small in nature and are meant to get our attention rather than perform 
lengthy data analysis. Already Crystal Decisions has web-enabled Report Alerts 
with their Enterprise application and now Alerts can be viewed from a mobile 
device.  
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Creating Report Alerts 
 
There are three steps to creating a Report Alert: 
 

• Name the Alert 
 

• Define the condition which triggers the Alert 
 

• Create the message that appears when the Alert is triggered (Optional) 
 
To create a Report Alert, click the Report menu and choose Alerts|Create or 
Modify Alerts. The Create Alerts dialog box opens. 
 

 
 

  
Click the New button and the Create Alert dialog box opens. 
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You can now name the alert. Type in your message and then click the condition 
button, which opens the Alert Formula Editor, to provide the conditions for the alert.  
If you don't want the same message all the time, you can provide a conditional 
message as well. 
 
Keep in mind the following when creating your Alert condition: 
 

• Alert formulas can be based on recurring records or summary fields, but 
they cannot be based on print-time fields, running totals, or print time 
formulas. Also Alert formulas cannot have shared variables 

 
• If an Alert formula is based on a summary field, any recurring fields used 

must be constant over the summary field you are using 
 

• Alert formulas can use either Crystal Syntax or Basic Syntax 
 
 

To see how Report Alerts work, you are going to edit the Exercise1_0.rpt report 
that you created earlier in class.  Suppose you want to be alerted to any suppliers 
who placed fewer orders than normal for the year.  You will need to create a 
summary field that counts the number of orders for each supplier. This summary 
field will be the basis of the Report Alert condition. You want to know when this 
total is less than 100. 
 

 Exercise 9.0 – Create a Report Alert 
 
1. Open the Monthly Sales by Supplier and Product.rpt report. 
 
2. Add a summary on the Order ID field to the Group Footer # 1 that 

performs a count of the Order ID field. 
 

3. Move the summary field to the right so that you have room to place a 
label in front of it that says # of orders: 

 
4. In the Report menu, choose Create or Modify Alerts. 
 
5. Click the New button on the Create Alerts window. 
 
6. Type Low Order Count for the name. 
 
7. The message will be: There are suppliers who placed fewer than 

normal orders for the year. 
 
8. Click on the condition button. This opens the Alert Condition Formula 

Editor. 
 
9. The condition formula is: 

 
Count ({Orders_Detail.Order ID}, {Supplier.Supplier Name}) < 100 
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10. Save and close the formula condition. Then make sure the enabled box 
is checked and click OK. 

 
11. Click the Close button on the Create Alerts window and save the 

report as Monthly Sales by Supplier and Product with Alerts.rpt 
 
12. Refresh the report.  The Report Alerts window should pop-up because 

the alert was triggered.  You can click on the View Records button to 
see which suppliers placed fewer than 100 orders.  Clicking View 
Records will show those records on their own tab named Low Order 
Count. 

 

  
 

 
 

13. Close the report when you are finished. 
 
 

 
 Exercise 9.1  - Using Report Alerts with Parameters

 
The goal in this exercise is to create an Alert for Regions whose total sales 
is above the user specified amount entered via a parameter. 
 
1. Begin a new report as a blank report.  Add the Customer and Orders 

tables. 
 
2. Group by Region. 
 
3. Select only records with Order Dates in 2004. 
 
4. Add a title that says:  2004 Regional Sales    Format the title however 

you like. 
 
5. Add the OrderID, Order Date, and Order Amount fields to the Details 

section. 
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6. Summarize the Order Amount field using the Sum summary operator. 
 
7. Resize the Group #1 Name field to be about 1'' wide and then move it 

from the Group Header #1 section to the Group Footer #1 section.  
Move the column headings from the Page Header section to the Group 
Header #1 section. 

 
8. Suppress the Page Header section.  Hide both the Group Header #1 

and Details sections. 
 
9. Create a parameter field called Sales Threshold.  Specify a number 

type. Enter the following prompting text:  Enter the $ amount of your 
Regional Sales Alert level. Regions with sales over this amount 
will trigger a Report Alert.    

 
 
10. Create a Report Alert called Regional Sales Level Alert.  Type in the 

message: The following Regions exceeded your sales level 
threshold. For the condition, you want the Alert triggered when the 
Regional summary is greater than your parameter entry.  

 
 Sum ({Orders.Order Amount}, {Customer.Region}) > 
 {?Sales Threshold} 
 
11. Save the report as Regional Sales Alert.rpt and preview the report. 

Enter 150000 for the parameter prompt.  Click view records to see 
which Regions exceeded $150,000 for total sales.  You should see BC, 
CA, IL, PA, and WI. 
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Basing Report Formulas or Conditional Formatting on Report Alerts

 
While the dialog of showing Report Alerts having been triggered is useful 
you may also want to incorporate information into your report about the 
Alerts and if they have been triggered.  There are three functions in the 
Crystal Reports Formula language that support Alerts as follows: 
 
• IsAlertEnabled:  Returns the value True if the Alert enabled checkbox is 

checked otherwise it returns False 
 
• IsAlertTriggered: Returns True if the record the formula is evaluating 

triggers the alert otherwise it returns False 
 
• AlertMessage: Returns the message that was typed into the Message 

box or the results of the Message string formula 
 

 Exercise 9.2:  Use the Alert Functions in Your Alert Report 
 
1. Open the Regional Sales Alert .rpt report and create a formula named 

AlertTriggeredMessage in the Group Footer that displays a message 
if the region triggered the alert. 
 

2. Your formula should read as follows: 
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3. Save your report (Regional Sales Alert) which should look as follows: 
 
 

 
 
4. Now let’s conditionally format the Group Footer to have a silver 

background if the alert is triggered.  Using the Section Expert enter the 
following formula: 

 
If IsAlertTriggered ("Regional Sales Level Alert") Then crSilver 
Else crNoColor 
 
Your report should look as follows: 

  

 
 
5. Save and close the report. 
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Creative Usage for Report Alerts

Report Alerts were created as a way to identify exception reporting.  
Although this was the original basis for this function, there are additional 
ways to use this key feature to enhance your reporting process.  One idea 
you might consider is to use Report Alerts as a means to query a saved 
dataset.  Once you have run a query against the database, you may need 
to see different data segments.  This generally requires that you rerun the 
report with different parameters or it may even be necessary for you to 
have multiple reports to manage. 
 
The main benefit of having the ability to query saved data within a report is 
that you can view different slices of the data output without having to rerun 
the report against the database.  This saves you valuable time that you 
would normally spend populating parameters and refreshing the report, as 
well as relieving unnecessary queries on the database server.  Your 
database administrator will definitely appreciate the reduced stress load on 
the server! 
 
To see how this process works, consider the following:  Suppose you are 
the manager of a product fulfillment center and you have a Order Tracking 
Report that you use to monitor orders that have been received during 2004.  
You have several additional reports that retrieve the same data with the 
exception of a few data restriction elements.  Currently you have the 
following reports that you manage on a daily basis: 
 
• Order Tracking Report 
• Payment Received Report 
• Domestic Shipping Report 
• International Shipping Report 
• Days to Ship Report 
 
Image how long it would take to run all of the daily reports required to do 
your job, if each report took 20 minutes to process.  What if using Report 
Alerts could produce all of the data segments in one report?  

 
 
 

 
Exercise 9.3:  Create the Order Tracking Report

 
 
 
 
 
 
 
 
 
 

 
1. Create a new report using the File>New>Blank Report Option.  Select 

the Customer and Order tables from the Xtreme Sample Database 
11.   Verify that the link was created between the two tables on the 
Customer_ID field. 

 
2. Using the Select Expert option set the Order Date field to only retrieve 

records for 2004.  You also only want to see those records that have 
been shipped.  Do this by adding another data filter for the Shipped 
field.  Set the value to is True. 
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3. Modify the page orientation to Landscape by selecting File>Page 
Setup.  

 
4. Add the following fields to the details section of the report:  Order ID, 

Order Date, Order Amount, Customer Name, Shipped Date, Ship 
Via, and Payment Received. 

 
5. Create a formula named Days to Ship using the following structure: 
 

{Orders.Ship Date} - {Orders.Order Date} 
 
6. Add a text object to the Report Header with the text Order Tracking 

Report.  Format the text box so it looks good to you.   
 

7. Format all of the date fields to display the date only. 
 

8. Save the report as Order Tracking Report.rpt and preview your 
results.   

  
The report should look similar to the sample below. 
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 Exercise 9.4:  Use Report Alerts to Query Saved Data  
 
You are now ready to create the Report Alerts.  You will create four 
individual alerts that will allow different slices of the data to display.  The 
alerts will query the saved dataset, so there will only be one query sent to 
the database. 
 
1. Return to the Design view of the report. 
 
2. Select the Report>Alert menu option.  Select Create or Modify Alerts 

option.   
 
3. Create a Report Alert by selecting the New button.  Name the alert 

Domestic Shipping Data.  Verify that the Enabled option is checked 
and select the Condition button. 

 
4. Use the following formula for the condition: 

 
{Customer.Country} = "USA" 

 
5. Save and Close the Formula Workshop and then select OK to return to 

the Alert listing. 
 
6. Create a new alert titled International Shipping Data where the 

formula for the condition is: 
 
{Customer.Country} <> "USA" 

 
7. Create a new alert titled No Payment Received Data where the 

formula for the condition is: 
 
{Orders.Payment Received} = False 

 
8. Create a new alert titled Days to Ship Greater than 10 Data where the 

formula for the condition is: 
 
{@Days to Ship}>10 

 
9. Close the Create Alerts window and Refresh the report.  The following 

window will display:  
 
 

  



 

 233

Crystal Reports XI Designer 2 Workshop ©2006 Vision Harvest, Inc.
Lesson 9: Report Alerts 
 
 
 
 

 
10. Select the Days to Ship Greater than 10 Data alert and then the View 

Records button. 
 
Your Preview should look like the following: 

 
  
 
Clicking on the Preview tab will redisplay the Report Alerts dialog box. You 
can then select a different alert and click the View Records button or click 
Close to display the normal report with all records. 
 
11. Save (Order Tracking Report) and close the report. 
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